
คู่มือการใช้งาน 
โปรแกรมงานวิชาการชั้นเรียน-วิชาการโรงเรียน 

หลักสูตรการศึกษาปฐมวัย พุทธศักราช 2560 
หลักสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศักราช 2551 

(ฉบับปรับปรุง 2560) 

 

 โปรแกรมประเมินพัฒนาการเด็กปฐมวัย  
 โปรแกรม ปพ.1-7 แบบมาตรฐาน ระดับประถมศึกษา 
 โปรแกรม ปพ.1-7 แบบมาตรฐาน ระดับมัธยมศึกษา 
 

 

โดยเพจวิชาการ  
www.facebook.com/thaischool  

 

1 พฤษภาคม 2564

http://www.facebook.com/thaischool


1. โปรแกรมนี้คืออะไร มีระดับใดบ้าง? 
โปรแกรมงานวิชาการช้ันเรียน-วิชาการโรงเรียน เป็นโปรแกรม Excel สำเร็จรูป ที่ใช้อำนวยความสะดวก
ในการจัดเก็บข้อมูลและออกเอกสารวิชาการช้ันเรียน และวิชาการโรงเรียน มีทั้งหมด 3 ระดับคือ 
1.1. โปรแกรมประเมินพฒันาการเด็กปฐมวัย หลักสูตร 2560 
1.2. โปรแกรม ปพ.1-7 แบบมาตรฐาน ระดับประถมศึกษา 
1.3. โปรแกรม ปพ.1-7 แบบมาตรฐาน ระดับมัธยมศึกษา 

 

2. ความสามารถของโปรแกรม ทำอะไรได้บ้าง? 

2.1. ความสามารถของโปรแกรมปฐมวัย โดยสรปุมีดังนี ้
2.1.1. การบันทึกผลการประเมินพัฒนาการเดก็ปฐมวัย 

2.1.1.1. สามารถนำเข้าข้อมูลนกัเรียนจากระบบ DMC ของ สพฐ. ได ้
2.1.1.2. สรปุเวลาเรียนอัตโนมัต ิ
2.1.1.3. การบันทึกน้ำหนกั-ส่วนสูง และการประเมินภาวะโภชนาการ 
2.1.1.4. สรปุปัญหาภาวะโภชนาการ เป็นรายภาคเรียนและรายป ี
2.1.1.5. รายงานอัตราความชุกปัญหาโภชนาการ 
2.1.1.6. การประเมินมาตรฐานพัฒนาการ ตัวบ่งช้ี และสภาพที่พึงประสงค์ 12 มาตรฐาน 29 

ตัวบ่งช้ี 59 สภาพที่พึงประสงค์ ดังนี้ 
2.1.1.6.1. พัฒนาการด้านร่างกาย มาตรฐานที่ 1-2 มี 5 ตัวบ่งช้ี 13 สภาพที่พึงประสงค์ 
2.1.1.6.2. พัฒนาการด้านอารมณ์ จิตใจ มาตรฐานที่ 3-5 มี 7 ตัวบ่งช้ี 11 สภาพที่พึง

ประสงค์ 
2.1.1.6.3. พัฒนาการด้านสังคม มาตรฐานที่ 6-8 มี 8 ตัวบ่งช้ี 17 สภาพที่พึงประสงค์ 
2.1.1.6.4. พัฒนาการด้านสติปญัญา มาตรฐานที่ 9-12 มี 7 ตัวบ่งช้ี 18 สภาพที่พึงประสงค์ 

2.1.1.7. การรายงานนักเรียนที่ควรเสริมพฒันาการ 
2.1.1.8. สามารถปรินท์รายงานได้ทัง้แบบรายเทอมและรายปี 

2.1.2.สามารถสรปุเป็นแบบรายงานประจำตัวเด็กปฐมวัย ได้โดยอตัโนมัติ เพื่อรายงานใหผู้้บริหาร
สถานศึกษาและผูป้กครองทราบผลการประเมินพัฒนาการ 

2.1.2.1. หน้าปกสรปุรายละเอียดนักเรียนรายบุคคล 
2.1.2.2. คำแนะนำสำหรบัผูป้กครอง 
2.1.2.3. สรปุข้อมลูนักเรียน 
2.1.2.4. ผลการประเมินภาวะโภชนาการ 
2.1.2.5. สรปุเวลาเรียน 
2.1.2.6. มาตรฐานพฒันาการ 4 ด้าน รายภาคเรียน-รายป ี
2.1.2.7. สรปุผลการประเมินพัฒนาการ 
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2.1.2.8. ความคิดเห็นของครปูระจำช้ัน 
2.1.2.9. ความคิดเห็นของผู้ปกครอง 

2.1.3. การออกใบรับรองผลการศึกษา 
2.1.4. โปรแกรมประเมินพฒันาการเด็กปฐมวัย รองรับนกัเรียนไฟล์ละ 45 คน/ห้อง 
2.1.5. สามารถคัดลอกไฟล์โปรแกรมได้ไมจ่ำกัดจำนวนไฟล์ ไมจ่ำกัดจำนวนเครื่องคอมพิวเตอร์ 
2.1.6. มีระบบช่วยเหลือระยะไกลผ่านโปรแกรม TeamViewer 
 

2.2. ความสามารถของโปรแกรมงานวิชาการโรงเรียน ระดบัประถมศึกษา-มัธยมศึกษา โดยสรุปมีดงันี ้
2.2.1. สามารถออกเอกสาร ปพ.1-7 ตามหลกัสูตรแกนกลางการศึกษาข้ันพื้นฐาน พุทธศักราช 2551 
2.2.2. สามารถนำเข้าข้อมลูนักเรียนจากระบบ DMC ของ สพฐ. ได ้
2.2.3. รองรบัคะแนน O-NET จาก สทศ อัตโนมัติ (ภาษาไทยมีคะแนนอัตนัย)  
2.2.4. คะแนน O-NET จบัคู่กับรายช่ือนักเรียนอัตโนมัติ ไม่ต้องกรอกเอง ไม่ต้องจัดเรียงข้อมลูใหม ่
2.2.5. ปพ.5-6 ประเมินผลสมัฤทธ์ิทางการเรียน ได้ 20 รายวิชาต่อเทอม/ปี 
2.2.6. รองรบัข้อสอบกลาง (สำหรับช้ัน ป.2 ป.4 ป.5 ม.1 และ ม.2) 
2.2.7. สามารถกำหนดร้อยละของข้อสอบกลางได้  
2.2.8. สามารถบันทึกได้ทั้งแบบสอบปลายปีการศึกษาปกติ และข้อสอบกลาง ในโปรแกรมเดียว 
2.2.9. สามารถเพิม่หรือลดจำนวนช่องกรอกคะแนนได ้
2.2.10. โปรแกรม ปพ.5-6 ประถมศึกษา สามารถกรอกคะแนนได้วิชาละ 50 ตัวช้ีวัด/เทอม/ปี (และ

สามารถเพิ่มหรือลดช่องกรอกคะแนนได้อัตโนมัติ) 
2.2.11. โปรแกรม ปพ.5-6 มัธยมศึกษา สามารถกรอกคะแนนได้วิชาละ 45 ตัวช้ีวัด/เทอม  

(และสามารถเพิ่มหรือลดช่องกรอกคะแนนได้อัตโนมัติ) 
2.2.12. สรปุเวลาเรียนอัตโนมัติ  
2.2.13. การประเมินคุณลักษณะอันพงึประสงค์  
2.2.14. การประเมินการอ่าน คิดวิเคราะห์ และเขียนสือ่ความ  
2.2.15. การประเมินค่านิยมหลัก 12  ประการ 
2.2.16. การประเมินสมรรถนะสำคัญของผู้เรียน  
2.2.17. การประเมินกจิกรรมพฒันาผู้เรียน 
2.2.18. สรปุรายงานผลการพัฒนาคุณภาพผูเ้รียนรายบุคคล (ปพ.6) เช่ือมโยงอัตโนมัต ิ
2.2.19. สรปุผลสมัฤทธ์ิทางการเรียนรายช้ันเรียนอัตโนมัติ 
2.2.20. โปรแกรม ปพ.1-2-3-7 รองรับนักเรียนไฟล์ละ 120 คน กรณีมีนักเรียนที่สำเรจ็การศึกษาใน

แต่ละปีการศึกษามากกว่า 120 คนสามารถคัดลอกไฟล์ต่อ ๆ ไปได้ 
2.2.21. โปรแกรม ปพ. 5-6 รองรับนกัเรียนไฟลล์ะ 45 คน/ห้อง 
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2.2.22. สามารถคัดลอกไฟล์โปรแกรมได้ไม่จำกัดจำนวนไฟล์ ไม่จำกดัจำนวนเครื่องคอมพิวเตอร์ 
2.2.23. มีระบบช่วยเหลือระยะไกลผ่านโปรแกรม TeamViewer 

 

3. ข้ันตอนก่อนการใช้งานมีอะไรบ้าง? 
3.1. ดาวน์โหลดไฟล์แนบ (.zip) ที่ส่งให้ทางกลอ่งข้อความเฟซบุก๊ www.facebook.com/thaischool 
3.2. ดับเบิล้คลกิเปิดไฟล์ .exe เพื่อติดตัง้โปรแกรมไปยังตำแหน่ง C:\โปรแกรมงานวิชาการโรงเรียน 

(สามารถเลือกตำแหนง่อื่นได้) 
3.3. ติดตั้งฟ้อนต์ที่ใช้แสดงผลในโปรแกรม โดยคัดลอกไฟล์ฟ้อนท์ไปยังตำแหนง่ C:\Windows\Fonts 
3.4. เลือกเปิดไฟล์ Excel (.xlsb) ที่ต้องการใช้งาน 
3.5. เปิดใช้งานแมโครทั้งหมดใน Excel โดยไปที่เมนู แฟ้ม>ตัวเลอืก>ศูนย์ความเช่ือถือ>การตัง้ค่าศูนย์

ความเช่ือถือ>การตัง้ค่าแมโคร>เปิดใช้งานแมโครทั้งหมด>ตกลง>ตกลง 
(เมนูภาษาอังกฤษ: File>Excel Options>Trust Center>Trust Center Settings>Macro 
Settings>Enable all macros>OK>OK 

3.6. กรอกไฟล์ละ 1 ห้องเรียน ห้องละไม่เกิน 45 คน ถ้ามีหลายห้องเรียนให้คัดลอกไฟล์ตามจำนวน
ห้องเรียน กรอกเฉพาะช่องทีเ่ป็นสีขาว ช่องสีชมพหูรือสีอื่น ๆ เป็นสูตร จะคำนวณให้อัตโนมัติ ไม่
ต้องกรอก 
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4. การใช้งานโปรแกรมระดับปฐมวัย มีลักษณะและวิธีการใช้งานอย่างไรบ้าง? 
4.1. หน้าหลัก/สารบญั เป็นหน้ารวมเมนูแผ่นงานทัง้หมดในโปรแกรม ซึง่สามารถ คลิกทีเ่มนูนั้น ๆ เพือ่ให้

เช่ือมโยงไปยังแผ่นงานต่าง ๆ ได้อย่างรวดเร็ว 
4.1.1. องค์ประกอบและการแบ่งหมวดหมู่ 
4.1.2. สามารถคลิกเมนู เพื่อเช่ือมโยงไปยงัแผ่นงานต่าง ๆ และคลกิปุ่ม Home สีเขียวเพื่อกลับหน้า

หลัก 

 
4.2. คู่มือ 

4.2.1. ควรศึกษาคู่มือให้เข้าใจ เพื่อให้ทราบวิธีการใช้งาน การแกป้ญัหา และข้อควรระวังในการกรอก
ข้อมูล 

4.3. ข้อมูลพื้นฐาน ได้กำหนดช่ือสถานศึกษาในโปรแกรมเรียบรอ้ยแล้ว ให้ดำเนินการกรอกข้อมูลพื้นฐาน
อื่น ๆ ที่จำเป็นให้ถูกต้อง 

4.3.1. สังกัด ให้กรอกสำนักงานเขตพื้นที่การศึกษา หรือองค์การปกครองส่วนท้องถ่ินที่สงักัด 
4.3.2. ตำบล/อำเภอ/จังหวัด ให้กรอกโดยมีคำว่า ตำบล/อำเภอ/จงัหวัดด้วย ในกรณีที่เป็น แขวง/เขต 

ให้กรอกคำว่า แขวง/เขต ด้วย 
4.3.3. ระดับช้ัน ให้กรอก อนุบาล หรือ เตรียมอนุบาล 
4.3.4. ปีที่ ให้กรอกตัวเลขช้ันปทีี่เรียน เช่น 1 2 หรือ 3 เป็นต้น 
4.3.5. อายุ ให้กรอกตัวเลขอายุช้ันปีของนกัเรียน เช่น 3 4 หรือ 5 เป็นต้น 
4.3.6. ห้อง กรอกตัวเลขห้องเรียนที่จัดทำข้อมูล 
4.3.7. ปีการศึกษา กรอกตัวเลขปกีารศึกษาทีจ่ัดทำข้อมลู 
4.3.8. กรอกช่ือ-สกลุ ครูประจำช้ัน/ครูที่ปรึกษา 
4.3.9. กรอกช่ือ-สกลุ และตำแหนง่ หัวหน้างานวิชาการ หรือนายทะเบียน ในกรณีออกใบรบัรอง 
4.3.10. กรอกช่ือ-สกุล และตำแหน่ง ผูบ้รหิารสถานศึกษา 
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4.4. ข้อมูลนักเรียน การนำเข้าข้อมลูจากระบบ DMC ช่ือไฟล์ studentInSchoolList.csv  สามารถ
คัดลอกข้อมลูนักเรียนจากระบบ DMC มาวางลงในแผ่นงานข้อมูลนักเรียนได้ ซึ่งมีวิธีการดังนี ้

studentInSchoolList.csv หากเป็นข้อมูลภาคเรียนที่ 2 ไฟล์จะอยู่ด้านล่างลงไปอีก ให้
เลื่อนหน้าเว็บไซต์ลงไปด้านล่างสุดเพื่อดาวน์โหลด 

 
4.4.1.5. เปิดไฟลท์ี่ดาวน์โหลดมาและคัดลอกข้อมูลนกัเรียนเฉพาะหอ้งที่ต้องการทำข้อมูล 
4.4.1.6. คลิกที่ตัวเลขหัวแถว เพื่อลากคลุมข้อมลูนักเรียนทั้งแถว 
4.4.1.7. กดปุ่ม Ctrl+C หรือคลิกขวาเลอืก คัดลอก (Copy) 
4.4.1.8. คลิกเปิดโปรแกรมงานวิชาการ ที่แผ่นงาน “ข้อมลูนักเรียน”  
4.4.1.9. คลิกขวาที่เซลล์ A3 เลือกเมนูตัวเลือกการวาง “ค่า (า)” 
4.4.1.10. จากนั้น กดปุ่มสีเขียวที่อยูด่้านขวามือ (ดูภาพประกอบ) หรอืกดปุ่ม Ctrl+D เพื่อ

ปรับปรงุข้อมลู  
4.4.2. การกรอกข้อมูลด้วยตนเอง ในกรณีที่ไมม่ีไฟล์ DMC หรือสงักัดอื่นนอกจาก สพฐ. สามารถ

กรอกข้อมูลใหม่ด้วยตนเอง (กรุณาอ่านคำแนะนำทีมุ่มสีแดง) วิธีการกรอกที่สำคัญมีดังนี ้

4.4.1.การดาวน์โหลดไฟล์ข้อมลูนักเรียนจากระบบ DMC (ดูภาพประกอบ) 
4.4.1.1. เข้าระบบ DMC ที่ https://portal.bopp-obec.info/obec64/ 
4.4.1.2. กรอกช่ือผู้ใช้งานและรหสัผ่าน คลิกเข้าสู่ระบบ 
4.4.1.3. คลิกเมนู โรงเรียน>2.9 รายงานระดับโรงเรียน 
4.4.1.4. ที่บรรทัด ทะเบียนนกัเรียนรายบุคคล คลิกดาวนโ์หลดไฟล์ 

https://portal.bopp-obec.info/obec63/
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4.4.2.1. รหสัโรงเรียน จำเป็นต้องกรอก ถ้าไม่กรอกข้อมูลอื่น ๆ จะไม่แสดง ถ้าไม่ทราบหรือ

เป็นสถานศึกษาที่ไม่ได้สังกัด สพฐ. ให้กรอกตัวเลขอะไรก็ได้ 
4.4.2.2. เลขประจำตัวประชาชน ให้กรอกตัวเลขเรียงปกติ ไม่ต้องมีวรรค หรือขีด โปรแกรม

จะประมวลผลใหเ้องเมื่อกดปุ่มสีเขียว 
4.4.2.3. เพศชายให้กรอก ช เพศหญิงให้กรอก ญ (ตามระบบของ DMC) ถ้ากรอกเป็นอย่าง

อื่นนอกจาก ช หรอื ญ โปรแกรมจะประมวลผลเป็นเพศหญงิ 
4.4.2.4. วันเกิด ให้กรอกในรปูแบบ วันที่/เดอืน/พ.ศ. เช่น 23/01/2554 โปรแกรมจะ

คำนวณอายุให้โดยยึดจากตัวเลขวันเกิดนี้ 
4.5. ข้อมูลเพิ่มเตมิ ให้กรอกข้อมลูเพิ่มเตมิทีจ่ำเป็น เช่น อาชีพบิดา มารดา และผูป้กครอง ตรวจสอบและ

แก้ไขที่อยู่ปัจจุบันของนักเรียนให้ถูกตอ้ง ความคิดเห็นของครูประจำช้ันด้านต่าง ๆ และในกรณีออก
ใบรับรอง ให้กรอกเลขที่ใบรับรอง คำรับรองนักเรียน วันเดอืนปีที่ออกให้ และหมายเหตุ 

4.6. ปกแบบบันทกึ ให้ตรวจ แก้ไข และกรอกจำนวนนักเรียน ชาย-หญิง ต้นปีการศึกษา ออก-เข้าระหว่าง
ปีการศึกษา และจำนวนรวมให้ถูกต้อง 

4.7. ช่ือนักเรียน บิดามารดา ผู้ปกครอง จะเป็นข้อมลูที่โปรแกรมประมวลมาจากแผ่นงานข้อมลูนักเรียน
และข้อมลูเพิม่เติมโดยอัตโนมัต ิ

4.8. เวลาเรียนให้กรอกเป็นตัวเลขจำนวนวัน (เลขอารบิก) 
4.8.1. มาเรียน   ให้กรอกเลข 1 
4.8.2. ป่วย       ให้กรอก ป 
4.8.3. ลา          ให้กรอก ล 
4.8.4. ขาด        ให้กรอก ข 
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4.8.5. วันหยุดเสาร์-อาทิตย์ และวันหยุดพิเศษ สามารถเว้นว่างไว้ได้ แต่ถ้าต้องการเพิ่มหมายเหตุ  
ว่าวันใดเป็นวันหยุดพิเศษ สามารถพมิพ์ในพื้นที่ตารางด้านลา่งใต้ช่ือนักเรียนคนสุดท้ายได ้

4.8.6. โปรแกรมจะสรุปเวลาเรียนให้โดยอัตโนมัติในแผ่นงาน “สรปุเวลาเรียน” 
4.9. การกรอกน้ำหนัก-ส่วนสงู ให้กรอกข้อมลู วันที่ช่ังน้ำหนัก/วัดส่วนสูง ในรปูแบบ 23/01/2554 เพื่อให้

โปรแกรมคำนวณอายุของนักเรียนออกมาเป็น ปี-เดือน และกรอกน้ำหนักเป็นกิโลกรัม และส่วนสงู
เป็นเซนติเมตร 
โปรแกรมจะคำนวณอายุนักเรียน และประมวลผลตามเกณฑ์มาตรฐานของกรมอนามัย กระทรวง
สาธารณสุขใหโ้ดยอัตโนมัติ ดังนี ้

4.9.1.น้ำหนักตามเกณฑ์อาย ุ
4.9.2.ส่วนสูงตามเกณฑอ์ายุ 
4.9.3.น้ำหนักตามเกณฑ์ส่วนสูง 
4.9.4.นอกจากนี้ โปรแกรมจะสรุปอัตราความชุกของปัญหาโภชนาการ และสรปุรายช่ือนักเรียนที่มี

ปัญหาโภชนาการให้โดยอัตโนมัต ิ
4.10. โปรแกรมจะประมวลผลการประเมินทัง้หมดมารายงานเป็นข้อมูลนักเรียนรายบุคคลให้โดย

อัตโนมัต ิ 
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4.11. มาตรฐานพฒันาการ ตัวบ่งช้ี และสภาพที่พงึประสงค์ 12 มาตรฐาน 29 ตัวบ่งช้ี 59 สภาพที่
พึงประสงค์ ทั้ง 4 ด้านคือ ด้านร่างกาย ด้านอารมณ์และจิตใจ ด้านสังคม และด้านสติปญัญา  
ไม่จำเป็นต้องแก้ไข สามารถยึดตามมาตรฐานของหลักสูตรการศึกษาปฐมวัย 2560 ที่กำหนดไว้แล้ว
ได้เลย  

 
4.11.1.  หากกำหนดในข้อมลูพื้นฐานเป็นช้ันปทีี่ 1 โปรแกรมจะดึงขอ้มูลตัวบง่ช้ีจากคอลัมน์  

A และ B ไปแสดงในตารางประเมินพัฒนาการ 
4.11.2.  หากกำหนดในข้อมลูพื้นฐานเป็นช้ันปทีี่ 2 โปรแกรมจะดึงขอ้มูลตัวบง่ช้ีจากคอลัมน์  

A และ C ไปแสดงในตารางประเมินพัฒนาการ 
4.11.3.  หากกำหนดในข้อมลูพื้นฐานเป็นช้ันปทีี่ 3 โปรแกรมจะดึงขอ้มูลตัวบง่ช้ีจากคอลัมน์  

A และ D ไปแสดงในตารางประเมินพฒันาการ 

 



ห น้ า  | 10 
 

 
คู่มือการใช้งานโปรแกรมงานวิชาการช้ันเรียน-วิชาการโรงเรยีน 

โดยเพจวิชาการ www.facebook.com/thaischool 

4.12. การประเมินพฒันาการ ทัง้ 4 ด้าน กำหนดผลเป็น 3 ระดับ ดังนี้ 
4.12.1.  ระดับคะแนน 1   =    ควรเสริม     

หมายถึง  ยังไม่พบพฤติกรรมที่แสดงพฒันาการ หรือยงัไม่ชัดเจน ควรได้รับการเสริมสร้าง
พัฒนาการให้ได้มาตรฐาน 

4.12.2.  ระดับคะแนน 2   =    พอใช้ 
หมายถึง  พบพฤติกรรมที่แสดงพัฒนาการเป็นบางครัง้ แต่ยังไม่คล่องและไมส่ม่ำเสมอ หรอื
พัฒนาได้ใกลเ้คียงมาตรฐาน 

4.12.3.  ระดับคะแนน 3     =    ดี 
หมายถึง  พบพฤติกรรมที่แสดงพัฒนาการได้บ่อย ปฏิบัติได้คล่องแคล่ว รวดเร็ว หรือพฒันาได้
ตามเกณฑ์มาตรฐาน 

โปรแกรมจะคำนวณและสรุปพัฒนาการและรายงานเด็กที่ควรได้รับการเสรมิพัฒนาการ ทั้งแบบราย
ภาคเรียน และแบบรายปกีารศึกษาใหโ้ดยอัตโนมัต ิ

4.13. โปรแกรมจะสรปุผลการประเมินพัฒนาการนักเรียนให้ทั้งแบบรายเทอมและรายปีว่านักเรียน
แต่ละคนมีผลการประเมินในระดบัใด  

4.14. โปรแกรมจะสรปุและจำแนกผลการประเมินเป็นรายตัวบง่ช้ีว่าในการประเมินแต่ละครัง้ แต่
ละตัวบ่งช้ีมีนกัเรียนได้รับผลการประเมินแต่ละระดับจำนวนเท่าใด 

4.15. โปรแกรมจะสรปุรายช่ือนักเรียนที่ควรได้รับการเสริมพฒันาการแต่ละด้านให้โดยอัตโนมัติ ทัง้
แบบรายเทอมและรายป ี

4.16. ในส่วนของความคิดเห็นและข้อเสนอแนะของครูประจำช้ัน สามารถกรอกได้ที่แผ่นงาน 
“ข้อมูลเพิ่มเติม” เริ่มจากคอลัมน์ “BD” เป็นต้นไป 

4.17. การสัง่ปรินท์ ผลการประเมินพัฒนาการนักเรียนรายบุคคล สามารถกรอกเลขที่ หรอืคลิกปุ่ม
สามเหลี่ยมช้ีลงค้นหาจากรายช่ือของเรียนที่ต้องการสั่งปรินท์ได้ 

4.18. สามารถสั่งปรินท์ที่ละคน โดยกรอกเลขที่ แล้วกดปุ่ม Enter เพื่อให้แสดงข้อมลูของนักเรียน 
หรือคลิกปุม่สามเหลี่ยมช้ีลง แล้วค้นหาจากรายช่ือของนักเรยีนที่ต้องการสัง่ปรินท์ คลิก “พมิพ์ข้อมลู
ที่แสดง” หรือปรินท์ครั้งเดียวทั้งห้องเรียนได้ เพือ่ความสะดวกในการทำรปูเล่มรายงาน โดยกรอก 
“เริม่พิมพจ์ากเลขที”่ “ถึงเลขที่” แล้วคลิก “พิมพ์เป็นช่วง”เช่น เลขที่ 1-45 เป็นต้น 
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4.18.1. สามารถสั่งปรินท์ใบรบัรองผลการศึกษา สำหรับนกัเรียนทีจ่บการศึกษาหรือย้ายสถานศึกษา
ได ้โดยกรอกข้อมลูที่แผ่นงาน “ข้อมลูเพิม่เติม” เริม่จากคอลัมน์ “BN” เป็นต้นไป 
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5. การใช้งานโปรแกรม ปพ.5-6 ระดับประถมศึกษาและมัธยมศึกษา มีลักษณะและ
วิธีการใช้งานอย่างไรบ้าง? 
5.1. โปรแกรม ปพ.5-6 ระดับประถมศึกษา แบ่งเป็น 2 ไฟลส์ำหรับใหโ้รงเรียนเลือกใช้งานตามบรบิท คือ  

5.1.1. แบบรายเทอม จะแบ่งการประเมินออกเป็น 2 ภาคเรียน มีการเกบ็คะแนนระหว่างเรียน และ
การสอบปลายภาค ทั้งภาคเรียนที่ 1 และภาคเรียนที่ 2 แลว้นำผลการเรียนทั้ง 2 ภาคเรียนมา
หาค่าเฉลี่ยเป็นผลการเรียนตลอดปกีารศึกษา 

 
 

5.1.2. แบบรายปี มกีารเก็บคะแนนระหว่างเรียนตลอดปี แต่จะมกีารสอบปลายปีครั้งเดียว แล้วคิด
เป็นผลการเรียนตลอดปีการศึกษา โดยไม่แยกเป็นภาคเรียนที่ 1 หรือภาคเรียนที่ 2 
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5.2. ระดับมัธยมศึกษา มีเฉพาะการประเมินผลสัมฤทธ์ิเป็นรายภาคเรียน (ไม่มรีายปี) 

 
 

5.3. ใน 1 ไฟล์กรอกนักเรียนได้ 1 ห้อง ห้องละไม่เกิน 45 คน ถ้ามีหลายห้องเรียนให้คัดลอกไฟล์ตาม
จำนวนห้องเรียน 

5.3.1.กรณีสอนประจำช้ัน นักเรียนกลุ่มเดียว ให้กรอกให้ครบทุกวิชาที่สอนใน 1 ไฟล์ 
5.3.2. กรณีสอนประจำวิชา ให้กรอกไฟล์ละห้องเรียน ไฟลล์ะวิชาแยกกัน และให้ครปูระจำช้ันหรือผู้ที่

ได้รับมอบหมาย ให้ทำไฟลร์วมอีก 1 ไฟล์เพื่อนำคะแนนรวมและเกรดจากครูประจำวิชาทุกวิชา 
มารวมในไฟล์ใหม่ เพื่อให้เป็น ปพ.6 และรายงานระดับห้องเรียน (ดูภาพตัวอย่างกระบวนการ) 

 
  เครดิตภาพ : โรงเรียนอนุบาลสังขละบุรี 
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5.4. หน้าหลัก/สารบญั เป็นหน้ารวมเมนูแผ่นงานทัง้หมดในโปรแกรม ซึง่สามารถ คลิกทีเ่มนูนั้น ๆ เพือ่ให้
เช่ือมโยงไปยังแผ่นงานต่าง ๆ ได้อย่างรวดเร็ว 

5.4.1. องค์ประกอบและการแบ่งหมวดหมู่ 
5.4.2. สามารถคลิกเมนู เพื่อเช่ือมโยงไปยงัแผ่นงานต่าง ๆ และคลกิปุ่ม Home สีเขียวเพื่อกลับหน้า

หลัก 
5.5. คู่มือ 

5.5.1. ควรศึกษาคู่มือก่อนการใช้งาน เพื่อให้ทราบวิธีการกรอกข้อมูล การแกป้ัญหา และข้อควรระวัง
ในการกรอกข้อมลู 

5.6. ข้อมูลพื้นฐาน ได้กำหนดช่ือสถานศึกษาในโปรแกรมเรียบรอ้ยแล้ว ให้ดำเนินการกรอกข้อมูลพื้นฐาน
อื่น ๆ ที่จำเป็นให้ถูกต้อง 

5.6.1. กรอกสงักัดระดับกรม เช่น สำนักงานคณะกรรมการการศึกษาข้ันพื้นฐาน หรือ สำนักงาน
บรหิารการศึกษาเอกชน  

5.6.2. กรอกตำบล/อำเภอ/จังหวัด 
5.6.3. กรอกสงักัดระดับเขต เช่น สำนักงานเขตพื้นที่การศึกษาประถมศึกษาขอนแก่น เขต 4 
5.6.4. กรอกช่ือ-สกลุ ผู้อำนวยการ นายทะเบียน หัวหน้างานวิชาการ และครปูระจำช้ัน/ประจำวิชา 

5.7. ข้อมูลนักเรียน  
5.7.1. การนำเข้าข้อมูลนกัเรียนจากระบบ DMC ของ สพฐ. ช่ือไฟล์ studentInSchoolList.csv  

สามารถคัดลอกข้อมลูนักเรียนจากระบบ DMC มาวางลงในแผ่นงาน “ข้อมลูนักเรียน” ได้ ตาม
ข้ันตอนดังนี ้

studentInSchoolList.csv หากเป็นข้อมูลภาคเรียนที่ 2 ไฟล์จะอยู่ด้านล่าง 
ให้เลือ่นหน้าเว็บไซต์ลงไปด้านล่างสุดเพื่อดาวน์โหลด 

5.7.1.1. การดาวน์โหลดไฟล์ข้อมลูนักเรียนจากระบบ DMC (ดูภาพประกอบ) 
5.7.1.1.1. เข้าระบบ DMC ที่ https://portal.bopp-obec.info/obec64/ 
5.7.1.1.2. กรอกช่ือผู้ใช้งานและรหสัผ่าน คลิกเข้าสู่ระบบ 
5.7.1.1.3. คลิกเมนู โรงเรียน>2.9 รายงานระดับโรงเรียน 
5.7.1.1.4. ที่บรรทัด ทะเบียนนกัเรียนรายบุคคล คลิกดาวน์โหลดไฟล์ 

https://portal.bopp-obec.info/obec63/
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5.7.1.2. เปิดไฟลท์ี่ดาวน์โหลดมาและคัดลอกข้อมูลนกัเรียนเฉพาะหอ้งที่ต้องการทำข้อมูล 
5.7.1.3. คลิกที่ตัวเลขหัวแถว แล้วลากคลุมข้อมูลนกัเรียนทั้งแถวลงดา้นล่าง 
5.7.1.4. กดปุ่ม Ctrl+C หรือคลิกขวาเลอืก คัดลอก (Copy) 
5.7.1.5. คลิกเปิดโปรแกรมงานวิชาการ ที่แผ่นงาน “ข้อมลูนักเรียน”  
5.7.1.6. คลิกขวาที่เซลล์ A3 เลือกเมนูตัวเลือกการวาง “ค่า (า)” ซึง่เป็นสัญลักษณ์เลข 123 
5.7.1.7. จากนั้น กดปุ่มสีเขียวที่อยูด่้านขวามือ (ดูภาพประกอบ) หรอืกดปุ่ม Ctrl+D เพื่อ

ปรับปรงุข้อมลู  
5.7.2. การกรอกข้อมูลด้วยตนเอง ในกรณีที่ไมม่ีไฟล์ DMC หรือสงักัดอื่นนอกจาก สพฐ. สามารถ

กรอกข้อมูลใหม่ด้วยตนเอง (กรุณาอ่านคำแนะนำทีมุ่มสีแดง) วิธีการกรอกที่สำคัญมีดังนี ้
5.7.2.1. รหสัโรงเรียน จำเป็นต้องกรอก ถ้าไม่กรอกข้อมูลอื่น ๆ จะไม่แสดง ถ้าไม่ทราบหรือ

เป็นสถานศึกษาที่ไม่ได้สังกัด สพฐ. ให้กรอกตัวเลขอะไรก็ได้ 
5.7.2.2. เลขประจำตัวประชาชน ให้กรอกตัวเลขเรียงปกติ ไม่ต้องมีวรรค หรือขีด โปรแกรม

จะประมวลผลใหเ้องเมื่อกดปุ่มสีเขียว 
5.7.2.3. เพศชายให้กรอก ช เพศหญิงให้กรอก ญ (ตามระบบของ DMC) ถ้ากรอกเป็นอย่าง

อื่นนอกจาก ช หรอื ญ โปรแกรมจะประมวลผลเป็นเพศหญงิ 
5.8. ข้อมูลเพิ่มเตมิ ให้กรอกข้อมลูเพิ่มเตมิทีจ่ำเป็น เช่น อาชีพบิดา มารดา และผูป้กครอง ตรวจสอบและ

แก้ไขที่อยู่ปัจจุบันของนักเรียนให้ถูกตอ้ง 
5.9. กำหนดรายวิชา ให้กรอกข้อมลูช้ันเรียน ภาคเรียน ปกีารศึกษา รหัสวิชา รายวิชา เวลาเรียน (ช่ัวโมง/

ปี) กลุม่สาระการเรียนรู้ และช่ือ-สกุลครูประจำวิชา โดยสามารถกำหนดรายวิชาได้สูงสุด 20 รายวิชา
ต่อปีการศึกษา 

5.9.1. กรณีสอนประจำช้ัน นักเรียนกลุม่เดียว ให้กรอกให้ครบทกุวิชาที่สอนใน 1 ไฟล์ 
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5.9.2. กรณีสอนประจำวิชา ให้กรอกไฟล์ละห้องเรียน (นักเรียนกลุ่มเดียว) ถ้าห้องเรียนนี้สอนหลาย
วิชาสามารถกรอกในไฟลเ์ดียวกันได้ เช่น ห้อง ป.6 สอนวิชาภาษาไทยและสังคมศึกษา สามารถ
ทำเป็นไฟล์เดียวกันได้ แต่ถ้าสอนหลายหอ้ง (นักเรียนหลายกลุ่ม) ให้แยกไฟลล์ะห้องเรียน เช่น 
สอนภาษาไทย ป.4 ป.5 และ ป.6 (นักเรียน 3 กลุ่ม) ให้แยกเป็น 3 ไฟล์เพราะรายช่ือนกัเรียน
คนละกลุม่กัน  

5.9.3. ปกแบบบันทึก ให้ตรวจ แก้ไข และกรอกจำนวนนักเรียน ชาย-หญิง ต้นปีการศึกษา ออก-เข้า
ระหว่างปีการศึกษา และจำนวนรวมให้ถูกต้อง โดยปกจะมทีั้งแบบรายช้ัน คือแสดงสรปุผลการ
เรียนทกุวิชา ใช้ในกรณีครูสอนประจำช้ัน (คนเดียวสอนทุกวิชา) และแบบรายวิชา คือแสดง
สรปุผลการเรียนแค่วิชาเดียว ใช้ในกรณีครูสอนประจำวิชา 

5.9.4. ช่ือนักเรียน บิดามารดา ผู้ปกครอง จะเป็นข้อมลูที่โปรแกรมประมวลมาจากแผ่นงานข้อมลู
นักเรียนและข้อมลูเพิ่มเตมิโดยอัตโนมัติ 

5.9.5. เวลาเรียน มีวิธีการกรอก ดังนี ้
5.9.5.1.  กรณีสอนประจำช้ัน กรอกเป็นจำนวนวันในแต่ละช่อง 

5.9.5.1.1. มาเรียน 1 วัน   ให้กรอกเลข 1 
5.9.5.1.2. ป่วย         ให้กรอก ป 
5.9.5.1.3. ลา           ให้กรอก ล 
5.9.5.1.4. ขาด         ให้กรอก ข 

5.9.5.2.  กรณีสอนประจำวิชา กรอกเป็นจำนวนช่ัวโมงในแตล่ะช่อง 
5.9.5.2.1. มาเรียน 1 ช่ัวโมง  ให้กรอกเลข 1 
5.9.5.2.2. ป่วย 1 ช่ัวโมง      ให้กรอก ป 
5.9.5.2.3. ลา 1 ช่ัวโมง       ให้กรอก ล 
5.9.5.2.4. ขาด 1 ช่ัวโมง      ให้กรอก ข 
5.9.5.2.5. มาเรียน 2 ช่ัวโมง  ให้กรอกเลข 2 
5.9.5.2.6. ป่วย 2 ช่ัวโมง      ให้กรอก ปป 
5.9.5.2.7. ลา 2 ช่ัวโมง       ให้กรอก ลล 
5.9.5.2.8. ขาด 2 ช่ัวโมง      ให้กรอก ขข 

5.9.5.3.  วันหยุดเสาร์-อาทิตย์ และวันหยุดพิเศษ สามารถเว้นว่างไว้ได ้แต่ถ้าต้องการเพิ่ม
หมายเหตุว่าวันใดเป็นวันหยุดพเิศษ สามารถพมิพ์ในพื้นที่ตารางด้านล่างใต้ช่ือนักเรียนคน
สุดท้ายได ้

5.9.5.4.  โปรแกรมจะสรุปเวลาเรียนให้โดยอัตโนมัติในแผ่นงาน “สรปุเวลาเรียน” 
5.10. การบันทึกผลสัมฤทธ์ิทางการเรียน คลกิที่แผ่นงานวิชาที่ต้องการบันทึก ซึ่งรายวิชาจะ

เช่ือมโยงมาจากแผ่นงาน “รายวิชา” โดยอัตโนมัต ิ
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5.10.1. ปุ่มควบคุมด้านขวา 5 ปุ่ม 

5.10.1.1.  ปุ่มบ้านสีเขียว กดเพื่อกลบัไปทีห่น้าหลัก/สารบัญ 
5.10.1.2.  ปุ่มเครื่องหมายบวกสีน้ำเงิน กดเพือ่เพิม่จำนวนคอลมัน์กรอกคะแนน 

(โปรแกรมรายปีเพิม่เป็น 48 ช่อง โปแกรมรายเทอมเพิม่เป็น 50 ช่อง) 
5.10.1.3.  ปุ่มเครื่องหมายลบสีแดง กดเพือ่ลดจำนวนคอลัมนก์รอกคะแนน (โปรแกรม

รายปลีดเป็น 12 ช่อง โปรแกรมรายเทอมลดเป็นเทอมละ 7 ช่อง 2 เทอมรวม 14 ช่อง) 
5.10.1.4.  ปุ่ม 20% สีม่วง กดเพื่อแปลงเป็นตารางสำหรบักรอกคะแนนข้อสอบกลาง 

ปุ่มนี้ห้ามกดซ้ำ 2 รอบ แต่กดสลบัไปมาได้กบัปุ่มยอ้นกลับสสี้ม 
5.10.1.4.1. ป. 2 กรอกคะแนนทดสอบกลาง เฉพาะวิชาภาษาไทย   
5.10.1.4.2. ป. 4-5 กรอกคะแนนทดสอบกลาง เฉพาะวิชาภาษาไทย คณิตศาสตร์และ

วิทยาศาสตร ์         
5.10.1.4.3. ม. 1-2 กรอกคะแนนทดสอบกลาง เฉพาะวิชาภาษาไทย คณิตศาสตร์

วิทยาศาสตร์ สังคมศึกษา และภาษาต่างประเทศ 
5.10.1.4.4. ช้ันอื่น ๆ ไม่มีต้องกรอกคะแนนทดสอบกลาง 

5.10.1.5.  ปุ่มย้อนกลับสสี้ม กดเพือ่ยกเลิกการ แปลงตารางข้อสอบกลาง ปุ่มนี้ห้าม
กดซ้ำ 2 รอบ แต่กดสลับไปมาได้กับปุ่ม 20% สีม่วง 

5.10.2. กำหนดอัตราส่วนคะแนนระหว่างเรียน : ปลายปี หรอื คะแนนระหว่างภาค : ปลายภาค 
5.10.3. กำหนดหัวข้อการเกบ็คะแนน สามารถกำหนดตามบรบิทของโรงเรียนได้ เช่น เป็นรายหน่วย 

รายตัวช้ีวัด ฯลฯ 
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5.10.4. กำหนดคะแนนเต็ม ในแต่ละช่องสามารถเก็บกี่คะแนนก็ได้ โปรแกรมจะคำนวณอัตราส่วนให้
อัตโนมัต ิ

 
5.10.5. กรอกคะแนนระหว่างเรียนแตล่ะช่อง โดยคะแนนที่ได้ ต้องไม่เกินคะแนนเตม็ที่กำหนด 
5.10.6. กรอกคะแนนทดสอบปลายภาค หรือปลายปี 
5.10.7. กรณีช้ัน ป.2 ป.4 ป.5 ม.1 และ ม.2 ในรายวิชาที่มีคะแนนข้อสอบกลาง ให้กำหนดร้อยละ

ข้อสอบโรงเรียน ร้อยละข้อสอบกลาง และคะแนนเต็มข้อสอบกลางด้วย 

 
ตัวอย่างการเก็บคะแนนระหว่างเรียน 

โรงเรียนสามารถกำหนดรูปแบบการเกบ็คะแนนระหว่างเรียนได้หลากหลายรูปแบบ แล้วแต่โรงเรียน 
เช่น รายหน่วย รายบท รายช้ินงาน รายกิจกรรม รวมทัง้คะแนนสอบระหว่างเรียน สอบกลางภาคได้ด้วย 
หรือหากโรงเรียนต้องการเกบ็เป็นรายตัวช้ีวัด สามารถคัดลอกรหสัตัวช้ีวัดของแต่ละวิชา แต่ละช้ัน ในไฟล์ 
Excel ที่แนบมาพรอ้มโปรแกรม ไปวางในหัวตารางเก็บคะแนนของแต่ละวิชาได้เลย (ต้องปุ่มเครื่องหมายบวก
สีน้ำเงิน             เพื่อเพิ่มจำนวนคอลัมนก์รอกคะแนนก่อน) 
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ตัวอย่างท่ี 1 
การกำหนดการเก็บคะแนนระหว่างเรียน เป็นรายตัวช้ีวัด ครบทกุตัว สามารถกำหนดคะแนนเต็มของแต่ละตัว
ได้โดยอิสระ เช่น เต็ม 10 ทุกช่อง ในกรณีนี้ ผลรวมของคะแนนเต็มทุกตัว ไม่เท่ากับสัดส่วนคะแนนระหว่าง
เรียน (เช่นรวมกันได้ 220) โปรแกรมจะเทียบสัดส่วนคะแนนให้อัตโนมัติ (เช่นเทียบสัดส่วน 220 เป็น 70) 
คะแนนรวมอาจจะมทีศนิยม 

 
 
ตัวอย่างท่ี 2 
การกำหนดการเก็บคะแนนระหว่างเรียน เป็นรายตัวช้ีวัด ครบทกุตัว โดยกำหนดคะแนนเต็ม เป็น 4 บ้าง 3 
บ้าง 2 บ้าง 1 บ้าง แล้วแต่จำนวนตัวช้ีวัด เพื่อให้ผลรวมของคะแนนเต็มทุกตัว เท่ากบัสัดส่วนคะแนนระหว่าง
เรียน (เช่น รวมกันได้ 70) ในกรณีนีจ้ะไม่มีการเทียบสัดส่วน จึงไม่มีทศนิยม 

 
 
ตัวอย่างท่ี 3 
การกำหนดการเก็บคะแนนระหว่างเรียน เป็นรายตัวช้ีวัด หลายตัวในช่องเดียว (เช่น รายมาตรฐาน) ทำให้ไม่
ต้องกระจายคะแนนหลายช่อง ผลรวมของคะแนนเตม็ทุกตัว เท่ากับสัดส่วนคะแนนระหว่างเรียน (เช่น รวมกัน
ได้ 70) ในกรณีนี้จะไมม่ีการเทียบสัดส่วน จึงไม่มทีศนิยม 
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5.11. การประเมินคุณลักษณะอันพงึประสงค์ การอ่าน คิดวิเคราะห์ และเขียนสื่อความ ค่านิยม
หลัก 12 ประการ และสมรรถนะสำคัญของผูเ้รียน มเีกณฑก์ารประเมินโดยใช้ค่าฐานนิยม (Mode) 
ดังนี ้

5.11.1. ระดับคะแนน 3   หมายถึง ระดบัคุณภาพ ดีเยี่ยม 
5.11.2. ระดับคะแนน 2  หมายถึง ระดบัคุณภาพ ดี 
5.11.3. ระดับคะแนน 1   หมายถึง ระดบัคุณภาพ ผ่าน 
5.11.4. ระดับคะแนน 0  หมายถึง ระดบัคุณภาพ  ไม่ผ่าน 
สำหรับการประเมินคุณลักษณะอันพึงประสงค์ มีช่องเพิ่มเตมิให้อีก 2 ช่อง จากเดมิ 8 ช่อง รวมเป็น 
10 ช่อง 

5.12. การประเมินกจิกรรมพฒันาผู้เรียน กำหนดผลเป็น 2 ระดับ คือ ไม่ผ่าน และ ผ่าน ให้ใส่
เครื่องหมาย / ลงในช่องว่าง 

5.13. เอกสารแนบท้าย ให้ปรินท์เอกสารแนบท้ายเล่ม ปพ.5 สามารถคลิกปุม่เพือ่เปิดเอกสารได้แต่
ต้องเกบ็ไฟลเ์อกสารแนบไว้ในโฟลเดอรเ์ดียวกับโปรแกรม หรือจะคลิกไฟล์เอกสารแนบเพื่อเปิด
โดยตรงตามปกติก็ได้ เอกสารแนบมีดงัต่อไปนี ้

 
5.13.1. รหสัตัวช้ีวัด ของแต่ละวิชา แต่ละช้ัน ให้ใช้ตัวช้ีวัดในหลักสูตรของโรงเรียน หรือใช้ไฟล์ที่แนบ

มานี้ (แต่ละโรงเรียนอาจจะกำหนดตัวช้ีวัดแตกต่างกัน) 
5.13.2. รายละเอียดตัวช้ีวัด ของแต่ละวิชา แต่ละช้ัน ให้ใช้ตัวช้ีวัดในหลักสูตรของโรงเรียน หรือใช้

ไฟล์ที่แนบมานี้ (แต่ละโรงเรียนอาจจะกำหนดตัวช้ีวัดแตกต่างกัน) 
5.13.3. คุณลักษณะอันพึงประสงค์ การอ่าน คิดวิเคราะห์ และเขียนสื่อความ 
5.13.4. ค่านิยมหลกั 12 ประการ 
5.13.5. สมรรถนะสำคัญของผู้เรียน 
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5.14. คำช้ีแจง ปพ.5 อธิบายการจัดเรียงหน้าเอกสารเมือ่สัง่ปรินทเ์พื่อรวมเป็นเลม่ ปพ.5  
ตามแผ่นงาน ดังนี ้

5.14.1. ปก ปพ.5 (รายช้ัน/รายวิชา) 
5.14.2. ช่ือนักเรียน 
5.14.3. บิดา-มารดา 
5.14.4. ผู้ปกครอง 
5.14.5. เวลาเรียน 
5.14.6. ผลสัมฤทธ์ิทางการเรียน (รายวิชาต่าง ๆ) 
5.14.7. คุณลักษณะอันพึงประสงค์/การอ่าน คิดวิเคราะห์ และเขียนสื่อความ 
5.14.8. ค่านิยม 12 ประการ/สมรรถนะสำคัญของผู้เรียน 
5.14.9. กิจกรรมพัฒนาผู้เรียน 
5.14.10. เอกสารแนบท้าย เช่น คำอธิบายรายวิชาและตัวช้ีวัด ตัวช้ีวัดค่านิยม 12 ประการ 

ฯลฯ 
5.14.11. ปกหลัง 

5.15. ปพ.6 เป็นแบบรายงานประจำตัวนักเรียนเพื่อรายงานผลการพัฒนาคุณภาพผูเ้รียนรายบุคคล 
โดยข้อมูลการประเมินต่าง ๆ ใน ปพ.5 ที่ครปูระเมินจะสรปุรวมเช่ือมโยงมายงัแผ่นงาน ปพ.6 โดย
อัตโนมัติ  

5.15.1. ในกรณีสอนแบบประจำวิชา ครูประจำช้ันหรอืผูท้ี่ได้รับมอบหมาย ให้ทำไฟล์อีก 1 ไฟล์เพือ่
นำคะแนนรวมและเกรด จากครูประจำวิชาทุกวิชา มาหลอมรวมในไฟล์ใหม่ เพือ่ให้เป็น ปพ.6 
และรายงานระดบัห้องเรียน เช่น สรปุผลสัมฤทธ์ิ ป.6 ปีการศึกษา 2560 เป็นต้น (นำมากรอก
เฉพาะช่องคะแนนรวมเต็ม 100 และผลการเรียน ในกรณีนกัเรียน ติด มส ร หรือย้าย ไม่ต้อง
คัดลอกมาทัง้หมด) 

5.15.2. ในกรณีสอนประจำช้ัน ใน 1 ไฟล์ต้องกรอกผลสมัฤทธ์ิทุกวิชาอยู่แล้ว  
5.15.3. การจัดเรียงลำดับที่ มีการจัดเรียง 2 แบบคือ ตามคะแนนรวม และตามเกรดเฉลี่ย  
5.15.4. สามารถปรินท์เอกสาร ปพ.6 นี้เพื่อรายงานให้ผูป้กครองทราบผลการพัฒนาคุณภาพผูเ้รียน 

สามารถสั่งปรินท์ทีละคน โดยกรอกเลขที่ แล้วกดปุ่ม Enter เพื่อให้แสดงข้อมลูของนักเรียน 
หรือคลิกปุม่สามเหลี่ยมช้ีลง แล้วค้นหาจากรายช่ือของนักเรยีนที่ต้องการสัง่ปรินท์ คลิก “พมิพ์
ข้อมูลที่แสดง” หรือปรินท์ครั้งเดียวทั้งห้องเรียนได้ เพือ่ความสะดวกในการทำรปูเล่มรายงาน 
โดยกรอก “เริม่พิมพจ์ากเลขที”่ “ถึงเลขที่” แล้วคลิก “พิมพ์เป็นช่วง”เช่น เลขที่ 1-45 เป็นต้น 

5.16. คะแนนรายช้ัน เป็นการสรปุคะแนนผลสัมฤทธ์ิทุกรายวิชาของนักเรียนทกุคนในห้องเรียน 
และการจัดลำดับที่คะแนนรวม 
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5.17. เกรดรายช้ัน เป็นการสรุปเกรดทุกรายวิชาของนักเรียนทุกคนในห้องเรียน และการจัดลำดับที่
เกรดเฉลี่ย 

5.18. เกรดร้อยละ เป็นการสรปุผลสมัฤทธ์ิ จำนวน และร้อยละของนักเรียนที่ได้ผลการเรียนใน
ระดับต่าง ๆ  

 

6. ข้อควรระวังในการกรอกข้อมูล 
6.1. กรุณาศึกษาคู่มือนี้ใหเ้ข้าใจก่อนเริม่ต้นใช้งาน หากเกิดความเสียหาย อาจไมส่ามารถกู้คืนข้อมลูได ้
6.2. รองรับ Windows Excel2010 ข้ึนไปเท่านั้น เวอร์ช่ันต่ำกว่าน้ันไฟล์จะเสียหาย (แนะนำ 2016) 

ไม่รองรับ MacOS 
6.3. ห้ามแทรก/ตัด/ลบ แถว/คอลัมน์/แผ่นงาน โดยเด็ดขาด เพราะจะทำให้การอ้างอิงสูตรไม่ถูกต้อง  

(ข้ึน #Ref) จะไม่สามารถแก้ไขได้ในกรณีนี้ ต้องเริ่มทำไฟล์ใหม่ ให้คัดลอกข้อมลูไปลงในไฟล์
โปรแกรมใหม ่

6.4. การคัดลอกข้อมลูจากไฟล์งานอื่น ๆ มาลงในโปรแกรม เวลาวางให้คลิกขวา เลือกเมนู "วางค่า" 
เท่านั้น  การวางด้วย Ctrl+V อาจจะทำให้โปรแกรมเสียหาย มีสูตรติดมาด้วย ลิงก์ข้ามไฟล์ 
โปรแกรมล็อค หรือเซลล์ลอ็ค และปญัหาด้านข้อมลู 

6.5. ในกรณีกรอกข้อมลูผิด ถ้าจะลบข้อมูลให้กดปุม่ Delete ที่คีย์บอร์ดเท่านั้น ห้ามคลิกขวาแล้ว 
Delete เพราะจะเป็นการลบเซลล์ ทำใหสู้ตรคลาดเคลือ่นและข้ึน #Ref 

6.6. ในกรณีนักเรียนย้าย หรอืลาออก ให้คงช่ือนักเรียนไว้จนสิ้นปีการศึกษา และกรอก “ย้าย” ในทุกช่อง
การประเมินแทน (กรอกในสรปุเวลาเรียน คะแนน เกรด กิจกรรม คุณลักษณะ ฯลฯ) สำหรบัระดบั
ปฐมวัย ให้ลง “ย้าย” ในผลการประเมินทั้ง 4 ด้านในเทอม 1 ด้วย (ลงย้ายทั้ง 2 เทอม) เพื่อให้
จำนวนผลการประเมิน ตรงกับจำนวนนักเรียนสิ้นปีการศึกษา 

6.7. นามสกลุไฟล์คือ .xlsb (Excel Binary Workbook) ห้ามเปลี่ยนนามสกุลไฟล์เพราะจะทำให้
โปรแกรมเสียหาย 

6.8. ควรศึกษาและปฏิบัติตามคู่มอืและคำอธิบายการกรอกในส่วนต่าง ๆ ที่ได้จัดทำไว้ 
6.9. หากท่านพบปญัหาในการใช้งาน ต้องการสอบถามข้อมลูเพิม่เติมหรือมีข้อเสนอแนะ สามารถติดต่อ

เพจวิชาการได้เสมอครับ www.facebook.com/thaischool 

  

http://www.facebook.com/thaischool
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7. คลิปสาธิตการใช้งาน 
    คลปิสาธิตการใช้งาน : https://www.youtube.com/c/วิชาการ 

    รวมคลปิสาธิตการใช้งานจากโรงเรียนที่ใช้งานจรงิครบั อธิบายอย่างละเอียด ทลีะข้ันตอน เข้าใจง่าย 
https://thaiexcel.blogspot.com/2019/08/blog-post.html 

 

8. การแก้ปัญหา Excel เบื้องต้น 
8.1. วิธีการเปลี่ยนเลขอารบิกใหเ้ป็นเลขไทย ในแบบ ปพ.2 (ประกาศนียบัตรระดับมัธยมศึกษา) 

8.1.1. คลิกขวาในเซลล์ทีจ่ะแก้ไข 
8.1.2. เลือก จัดรูปแบบเซลล ์
8.1.3. เลือก กำหนดเอง 
8.1.4. ในช่อง ชนิด ให้พิมพ์ว่า [$-D07041E]0 
8.1.5. กดตกลง 

8.2. ตัวเลขเปลี่ยนรูปแบบไปเมื่อกดปุ่ม Enter เช่นวันที่ วันเกิด เลขประจำตัวประชาชน 3.4105E+12 
8.2.1. ให้ใส่เครือ่งหมาย ' ลงไปกอ่นตัวเลข (อญัประกาศเดี่ยว) เช่น '31 มีนาคม 2561 

8.3. วิธีแก้วันเกิดแสดงเป็นภาษาอังกฤษ ให้แสดงเป็นภาษาไทย 
สาเหตุ : เกิดจากการตั้งค่าสถานที่และเวลาในระบบคอมพิวเตอร์ไม่ถูกต้อง 
วิธีแก้ไข : ตั้งค่า Format และ Location เป็น Thai (Thailand) ตามขั้นตอนดงันี ้
7.3.1 คลิกที่เวลาและวันที่ตรงมุมจอด้านขวาด้านล่างสุด 
7.3.2 คลิก Change date and time settings... 
7.3.3 คลิก Change date and time... 
7.3.4 คลิก Change calendar settings 
7.3.5 คลิก OK 
7.3.6 แถบ Format เลือก Thai (Thailand) 
7.3.7 แถบ Location เลอืก Thailand 
7.3.8 คลิก OK 

8.4. เวลาทำ ปพ.1 คะแนน O-NET ไม่ขึ้น สาเหตเุกิดจาก รูปแบบ เลขบัตรประชาชนนักเรียน ไม่ตรงกับ 
สทศ บางทีในแผ่นงานข้อมูลนักเรียนอาจจัดเกบ็เป็นตัวเลขที่เป็นข้อความ (เอาไปบวกลบไม่ได้) แต่
ใน สทศ เป็นแบบตัวเลข ดังนั้นต้องตั้งให้ตรงกัน ให้ตรวจสอบและดำเนนิการดงันี ้

8.4.1. ให้มั่นใจว่ากดปุ่มสีเขียวในแผ่นงาน สทศ และแผ่นงาน “ข้อมูลนักเรียน” แล้ว 

https://www.youtube.com/c/วิชาการ
https://thaiexcel.blogspot.com/2019/08/blog-post.html
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8.4.2. ให้ตรวจสอบ เลขประชาชนของนักเรียน ในแผ่นงาน “ข้อมลูนักเรียน” ใหม้ีรปูแบบตรงกันกับ
ในแผ่นงาน สทศ (เช่น ห้ามมีขีดค่ันหรือเว้นวรรค) 

8.4.3. หากยังไม่ได้ ให้ไปที่แผ่นงาน “ข้อมลูนักเรียน” จากนั้น คลกิขวาที่คอลัมน์ เลขประชาชน
นักเรียน แล้วเลือกจัดรูปแบบเซลล์ เลือกตัวเลข ไม่มีจุดทศนิยม กดตกลง 

8.4.4. หากยังไม่ได้ ให้คลิกที่เลขประชาชนนักเรียนคนแรก กดปุ่ม F2 และ Enter สลบักันไปเรื่อย ๆ 
จนถึงนักเรียนคนสุดท้าย เพื่อปรบัปรุงรูปแบบเซลล์ 

8.4.5. หากยังไม่ได้อีก ใหส้่งไฟล์มาที่ www.facebook.com/thaischool เพื่อให้ทมีงานตรวจสอบ
ให้ 

  

http://www.facebook.com/thaischool
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8.5. การแก้ปญัหาวันเกิดนักเรียนไม่ประมวลผล สาเหตุ เกิดจากการตั้งค่ารปูแบบวันที่ไม่ถูกต้อง 

 
8.5.1. ให้คลกิขวาที่คอลัมน์วันเกิดทั้งหมด เช่น คอลมัน์ M 
8.5.2. เลือกเมนู "จัดรูปแบบเซลล์" 
8.5.3. เลือก "ตัวเลข" 
8.5.4. เลือก "วันที่" 
8.5.5. ชนิดปฏิทิน เลอืก "เกรกอเรียน" หรือ "ตะวันตก" 
8.5.6. ชนิด เลือก "14/3/2012" 
8.5.7. ตำแหน่งที่ตั้ง เลือก "ไทย" 
8.5.8. คลิก "ตกลง"   จากนั้นสั่งใหโ้ปรแกรมประมวลผลการกรอกอีกครั้งโดย 
8.5.9. คลิกที่ช่องวันเกิดนกัเรียนที่กรอก 
8.5.10. กดปุ่ม F2 สลับกับปุ่ม Enter ลงไปเรื่อย ๆ จนครบทุกคน 
8.5.11. เช็คผลการแก้ไขว่าเรียบร้อยหรอืไม่ 

8.6. เอกสารแสดงไม่ครบหน้า หน้าเอกสารล้นไปหน้าที่ 2 
อาจเกิดจากการตั้งค่าบางอย่าง ข้ึนอยู่กบัการตัง้ค่าหน้ากระดาษ ปรินเตอร์และคอมพิวเตอร์ ให้ลอง
วิธีต่อไปนี้ 

8.6.1. ตั้งค่าหน้ากระดาษ ลดส่วนหัวกระดาษ ท้ายกระดาษลง 
8.6.2. ลดความสูงของบรรทัดลง 
8.6.3. ทำให้แผ่นงานพอดีกับหนึ่งหน้า ไปที่เมนู ไฟล์>พิมพ>์ไม่มมีาตราส่วน>ทำให้แผ่นงานพอดีกับ

หนึ่งหน้า (แต่ตัวหนงัสอืจะย่อลง) 
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8.6.4. ตั้งค่าพื้นที่พิมพ์ ไปทีเ่มนู มุมมอง>แสดงตัวอย่างเส้นแบง่หน้า แล้วลากเส้นประสีน้ำเงิน ไปทบั
เส้นทบึสีน้ำเงิน (แต่ตัวหนงัสือจะย่อลง) 

8.7. เวลากดปุม่สเีขียว โปรแกรมจะแจง้ว่ายังไม่เปิดใช้แมโคร หรอืไม่มีแมโครอยู่ในแผ่นงาน 
วิธีเปิดใช้งานแมโครทัง้หมดใน Excel  

8.7.1. ไปที่เมนู แฟ้ม>ตัวเลือก>ศูนย์ความเช่ือถือ>การตั้งค่าศูนย์ความเช่ือถือ>การตัง้ค่าแมโคร>เปิด
ใช้งานแมโครทั้งหมด>ตกลง>ตกลง 

8.7.2. เมนูภาษาอังกฤษ : File>Excel Options>Trust Center>Trust Center Settings>Macro 
Settings>Enable all macros>OK>OK 

8.8. วิธีการยกเลกิการซ่อนคอลัมน ์
8.8.1. เลือกคลุมข้อมลูทัง้หมด โดยนำเมาส์ไปคลิกสี่เหลี่ยมหน้าคอลัมน์ A (อยูเ่หนือเลข 1) 
8.8.2. คลิกขวา ที่หัวคอลัมน์ใดก็ได้ เช่น แถว ๆ คอลัมน์ ABC 
8.8.3. เลือก "ยกเลกิการซ่อน" คอลมัน์ที่ถูกซอ่นก็จะแสดงข้ึนมาทัง้หมด 

8.9. คลิกลงิก์ไม่ได้ เกิดจาก Windows ไมส่มบูรณ์  (เกี่ยวกบั Internet Explorer ด้วย) ให้ดาวน์โหลด
และติดตั้งตัวแก้ ลองทำทลีะตัว ดังนี้ 

8.9.1. MicrosoftEasyFix50388 จากลงิก์นี้ 
https://1drv.ms/u/s!AuCGLkEAcYapb3c5JZBHO1L-8LM  ดาวน์โหลดและติดตั้ง ถ้ายัง
ไม่ได้ ให้ใช้ไฟล์ที่ 2 

8.9.2. ดาวน์โหลดและติดตั้งไฟล์ Fix_Link_Click.reg จากลงิก์นี้ 
https://1drv.ms/u/s!AuCGLkEAcYapbsw8TYrPOt6AfcE  

8.9.3. สำหรบั Windows 10 ดาวน์โหลดไฟล์และติดตั้งไฟล์ Windows10_Fix_Link_Click.reg จาก
ลิงก์นี้ https://1drv.ms/u/s!AuCGLkEAcYapbUu-_pXbtMRHpbs  

8.9.4. เมื่อติดตั้งเสรจ็แล้วให้ Restart คอมพิวเตอร ์
8.9.5. ถ้ายังไม่ได้ก็ต้องเลือ่นทลีะแผ่นงานตามปกติครับ (กดปุ่ม Ctrl + Page Up  หรอื Ctrl + Page 

Down) 
8.10.  ไฟล์ DMC (.csv) เป็นภาษาต่างดาว 

8.10.1. การตั้งค่า Location เป็นภาษาไทย 
https://www.youtube.com/watch?v=Mk_gUIM2UcA 

8.10.2.  ถ้ายังไม่หายให้ตั้งค่าการแปลรหัสภาษา 
https://sysadmin.psu.ac.th/2018/09/17/open-thai-csv-excel-correctly 

8.11. ปัญหา Error 9 เมื่อกดปุม่รันอัตโนมัต ิ
8.11.1. ให้ตั้งค่า System Locale เป็น Thai (Thailand) และติ๊กเครื่องหมายถูกตรง Beta: Use 

Unicode ออก (ไม่ให้มเีครื่องหมายถูก) ตามข้ันตอนดังนี ้

https://1drv.ms/u/s!AuCGLkEAcYapb3c5JZBHO1L-8LM
https://1drv.ms/u/s!AuCGLkEAcYapbsw8TYrPOt6AfcE
https://1drv.ms/u/s!AuCGLkEAcYapbUu-_pXbtMRHpbs
https://www.youtube.com/watch?v=Mk_gUIM2UcA
https://sysadmin.psu.ac.th/2018/09/17/open-thai-csv-excel-correctly
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กดปุ่ม Start > พิมพ์ค้นหาคำว่า Region Settings เลือก Additional date > Region: 
Change date, time >  Administrative > Change Sytem Locale: Current System 
Locale > Thai (Thailand) > และติ๊กเครื่องหมายถูกตรง Beta: Use Unicode ออก (ไม่ให้มี
เครื่องหมายถูก) > OK 

  
8.12. หากมปีัญหาที่ไม่สามารถแก้ได้ด้วยตนเองหรือต้องการใหท้ีมงานช่วยเหลอื 

8.12.1.  สามารถติดต่อได้ที่เฟซบุก๊เพจวิชาการ www.facebook.com/thaischool 
8.12.2.  สามารถแนบไฟล์โปรแกรมมาให้ทีมงานช่วยแก้ไขให้ได้ทางกล่องข้อความเฟซบุ๊ก 
8.12.3.  ต้องการใหท้ีมงานเข้าถึงและการสนับสนุนระยะไกลผ่านทางอินเทอรเ์น็ตในคอมพิวเตอร์

ของท่านเลย ให้ติดตั้งโปรแกรม TeamViewer สำหรบัการเข้าถึงและการสนับสนุนระยะไกล
ผ่านทางอินเทอร์เน็ต โดยสามารถดาวน์โหลดได้จากลงิค์นี ้
https://download.teamviewer.com/download/TeamViewerQS.exe 
เมื่อดาวน์โหลดและติดตั้งโปรแกรมแล้ว ให้แจ้ง Your ID และ Password ที่ปรากฏมาทาง 
เฟซบุ๊กเพจวิชาการ www.facebook.com/thaischool เพือ่ให้ทีมงานออนไลน์และสนับสนุน
ระยะไกลผ่านอินเตอรเ์น็ต 

 
 
 

http://www.facebook.com/thaischool
https://download.teamviewer.com/download/TeamViewerQS.exe
http://www.facebook.com/thaischool
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โดยเพจวิชาการ  
www.facebook.com/thaischool  

 

ขอขอบพระคุณ

http://www.facebook.com/thaischool


 

เรื่อง  ประชาสัมพันธ์โปรแกรมงานวิชาการโรงเรียน ระดับปฐมวัย-ประถมศึกษา-มัธยมศึกษา 
 

เรียน  ผู้อำนวยการโรงเรียน ผูบ้รหิารสถานศึกษา ฝ่ายวิชาการ ฝ่ายทะเบียนวัดผล และผู้สนใจ 
 

สิ่งท่ีส่งมาด้วย 1. ใบสั่งซือ้     จำนวน  1  ฉบับ 
 

 

 โปรแกรมงานวิชาการโรงเรียน แบบมาตรฐาน ระดบัปฐมวัย-ประถมศึกษา-มัธยมศึกษา รองรับ Excel 
2010 ข้ึนไป อัพเดทล่าสุด มีความสามารถดังนี ้
 • ระดับประถมศึกษา-มัธยมศึกษา 
  - ออกเอกสาร ปพ.1-7 ตามมาตรฐานกระทรวงศึกษาธิการ หลักสูตรแกนกลาง 2551 และที่แก้ไขเพิ่ม 

- รองรับคะแนน O-NET จาก สทศ 2560 อัตโนมัติ (สอบ 4 วิชา - ภาษาไทยแบบมีอัตนัย)  
- O-NET จับคู่คะแนน จัดเรียงอัตโนมัติ ไม่ต้องกรอก 
- รองรับข้อสอบกลาง (ป.2 ป.4 ป.5 ม.1 ม.2) 
- ประเมินค่านิยม 12  ประการ (สรุปผลโดยใช้ฐานนิยม) 
- ประเมินสมรรถนะสำคัญของผู้เรียน (สรปุผลโดยใช้ฐานนิยม) 
- สามารถกำหนดร้อยละของข้อสอบกลางได้  
- กำหนดรายวิชาการสอบได้อิสระ 20 รายวิชา บันทึกได้ทั้งแบบสอบปลายภาคปกติ  
และข้อสอบกลาง ในโปรแกรมเดียว 
- มีปุ่มเพิ่ม-ลด จำนวนช่องกรอกคะแนนอัตโนมัติ ชอบกรอกละเอียดกดบวก ชอบกรอกน้อย ๆ กดลบ 
- รองรับข้อมูลจาก DMC คลกิเดียวจบ ไม่ต้องกรอกเอง 
- ปพ.5-6 ประถมสามารถกรอกคะแนนได้วิชาละ 50 ตัวช้ีวัด/เทอม/ปี (มปีุ่มขยาย-ลดช่องกรอก
คะแนนได้อัตโนมัติ) 
- ปพ.5-6 มัธยมสามารถกรอกคะแนนได้วิชาละ 45 ตัวช้ีวัด/เทอม (มีปุ่มขยาย-ลดช่องกรอกคะแนน
ได้อัตโนมัติ) 
- สรุปเวลาเรียนอัตโนมัต ิ
- กรอกได้ 20 รายวิชา/เทอม/ป ี
- รองรับนกัเรียน 45 คน/ห้อง 
- ระบบช่วยเหลือระยะไกลผ่าน TeamViewer 
 

  

  
 
 1 พฤษภาคม 2564
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• โปรแกรมประเมินพัฒนาการเดก็ปฐมวัย (สำหรับเด็กอายุต่ำกว่า 3 ปี และอายุ 3-6 ปี) 
- สามารถประเมินมาตรฐานพฒันาการ ตามหลกัสูตรการศึกษาปฐมวัย 2560 ครบทัง้ 12 มาตรฐาน 
29 ตัวบ่งช้ี 59 สภาพที่พงึประสงค์ 

- สรปุมาตรฐานรายข้อ 
- รายงานนักเรียนที่ควรเสริมพัฒนาการ 
- สรปุรวบยอดการประเมินพฒันาการ 
- สามารถปรินท์เล่มรายงานได้ทั้งรายเทอมและรายปี 
- รองรับข้อมูลนักเรียนจาก DMC คลกิเดียวจบ ไม่ต้องกรอกเอง 
- ประเมินและรายงานภาวะโภชนาการจากน้ำหนกัและส่วนสงูอัตโนมัต ิ
- รายงานอัตราความชุก ปัญหาโภชนาการ 
- สรปุเวลาเรียน คำนวณสัดส่วนอัตโนมัต ิ
- สมุดรายงานประจำตัวนักเรียนอัตโนมัต ิ  
- สามารถประเมินได้ทัง้รายบุคคลและรายช้ันเรียน 
- รองรับนักเรียน 45 คน/ห้อง 
- สามารถกำหนดตัวบ่งช้ีแยกแตล่ะช้ันปีได้ คำนวณและประมวลผลอัตโนมัติทกุขั้นตอน ใช้ได้ทั้งแบบ
รายภาคเรียนและรายปี รายช้ันเรียนและรายบุคคล 

- ระบบช่วยเหลือระยะไกลผ่าน TeamViewer 

 หากท่านประสงค์จะใช้งาน กรุณาโอนเงินสั่งซื้อตามรายละเอียดใบสั่งซื้อ มาที่บญัชีออมทรัพย์ 
ธนาคารกรุงไทย สาขากมุภวาปี บัญชีเลขที่ 4180011816 ช่ือบัญชี นายชัชวาลย์ รินทร์วงศ์ แจ้งรายละเอียด
การโอนเงิน ช่ือโรงเรียน สังกัด และระดับช้ันทีส่ั่งซือ้เฟซบุ๊กเพจวิชาการ www.facebook.com/thaischool 
เมื่อได้รบัข้อมลูและค่าลงทะเบียนครบถ้วนถูกต้องแล้ว จะจดัส่งโปรแกรม คู่มือการใช้งาน ใบสำคัญรับเงิน
พร้อมสำเนาบัตรประจำตัวประชาชนและสำเนาทะเบียนบ้านให้ทางเฟซบุ๊กภายใน 1 วัน 
  

  จึงเรียนมาเพื่อโปรดพจิารณาและสามารถสอบถามข้อมูลเพิม่เติมได้ที่ โทร. 081-0555-098  
จักกราบขอบคุณเป็นอย่างสงู        

       
  

ขอแสดงความนับถือ 
                

    
       (นายชัชวาลย์ รินทร์วงศ์)

http://www.facebook.com/thaischool


      
      

ใบสั่งซื้อ 
 

  ข้าพเจ้า.......................................................................ตำแหน่ง.......................... ..................................  
เบอร์โทรศัพท์..............................................มีความประสงค์สั่งซือ้โปรแกรมสำหรบัพิมพ์เอกสารทางการศึกษา  
ดังนี้ (โปรดทำเครื่องหมาย) 

(  ) โปรแกรมประเมินพัฒนาการเด็กปฐมวัย 

1. ช่ือเต็มโรงเรียน/สถานศึกษา…………………………………….………………………………………………………… 
2. สังกัด (ระดับเขต/อบต./เทศบาล)…………………….…………………………………………………………………. 
3. จังหวัด…………………………………………………………...……………………………………………….………………. 
4. ช่ือเฟซบุก๊สำหรบัติดต่อและรับไฟล์………...…………….……………………………………………………………. 

 
ทั้งนี้ ข้าพเจ้าได้โอนเงินค่าลงทะเบียนสั่งซื้อจำนวน……………บาท ไปยังบญัชีออมทรัพย์ 

ธนาคารกรุงไทย สาขากมุภวาปี บัญชีเลขที่ 4180011816 ช่ือบัญชี นายชัชวาลย์ รินทร์วงศ์ ผ่านทาง  
   (   ) เคาเตอร์ธนาคาร วันที่…….….เดือน….….……………..พ.ศ…….…….เวลาประมาณ…………………น. 
   (   ) เอทีเอ็ม    วันที่…….….เดือน.…….……………..พ.ศ…….…….เวลาประมาณ…………………น. 
   (   ) อินเตอร์เน็ต  วันที่…….….เดือน.…….……………..พ.ศ…….…….เวลาประมาณ…………………น. 
   (   ) อื่น ๆ (ระบุ)..............วันที่…….….เดือน……...……………..พ.ศ…….…….เวลาประมาณ…………………น. 
 

(ลงช่ือ)..................................................
(............................................................)  
วันที่............/............................./........... 

หมายเหต ุราคาข้างต้น มีผลถึงวันที่ 30 เมษายน 2564 เท่านั้น หลังจากนั้นโปรดสอบถามที่เพจวิชาการ  
www.facebook.com/thaischool หรือ โทร. 0810555098 (คุณชัชวาลย์ รินทร์วงศ์) 
  

CODE20210501 

          ราคา   1,200 บาท 
(  ) โปรแกรม ปพ.1-7 ระดับประถมศึกษา                    ราคา   1,200 บาท 
(  ) โปรแกรม ปพ.1-7 ระดับมัธยมศึกษา            ราคา   1,200 บาท 
(  ) รวมระดับปฐมวัย และประถมศกึษา     ราคา   2,400 บาท 
(  ) รวมระดับประถมศึกษา และมัธยมศึกษา    ราคา   2,400 บาท 
(  ) รวมระดับปฐมวัย ประถมศึกษา และมัธยมศึกษา   ราคา   3,600 บาท 
 
และขอแจง้ข้อมูลสำหรบัการลงทะเบียน ดังนี้ 

http://www.facebook.com/thaischool
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คู่มือการใช้งานโปรแกรมงานวิชาการช้ันเรียน-วิชาการโรงเรยีน 

โดยเพจวิชาการ www.facebook.com/thaischool 

 
 

 

 


